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◊ After entering each number, the scaling percentage is automatically calculated: 

 

 

 

◊ Click on Update and a prompt window will ask if you want to Apply Scale Adjustment. Click on Yes 
and you’ll be back in the Vinyl Spooler window. To verify the scaling, again click on Cutter Scale and 
repeat the same steps. Make sure you leave your new scale factors in place by having the following 
option marked: 

 

 

◊ Once your test rectangle is drawing at the correct size, the calibration process is complete.  

 

 

2.08.2 Scale Calibration Using Inches for Measurement 

• SignMaster has a built-in resolution routine which can be used to easily perform this calibration: 

◊ Go to the Vinyl Spooler window and select the Calibration tab. Click on the Cutter Scale icon: 

 

◊ A new window opens where you can enter the dimensions of a square or rectangle to draw with the test 
pen. It is highly recommended that the dimensions be at least 8 inches:  

 

 

Calculated Scale values 

Click on Update 

Leave this checked for 
each repeated test 

1. Select the 
Calibration tab 

2. Click on the Cutter Scale icon 

https://manuals.plus/m/0e1f26265093fcde326016c262f1803f6a0fad19fa07e2791f0e208d06a6474e
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◊ Load a sheet of paper and insert the test pen. Move the test pen to the lower right corner of the paper. 
Make sure you have proper settings for drawing and click on Cut Test to have the shape drawn.  

◊ Using a ruler, carefully measure the Width (left-to-right) and the Height (top-to-bottom) that drew:   

 

◊ Write these measurements onto your sheet: 

 

Width, X 

Height Y 

Feed the mat this direction 
into the Skycut 

Enter Width and 
Length to use for test 
shape 

Click here to start the drawing 
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◊ Convert the measurements to decimals and enter these values into the same Width and Length fields. 
After entering each number, the scaling percentage is automatically calculated: 

            

 

◊ Click on Update and a prompt window will ask if you want to Apply Scale Adjustment. Click on Yes 
and you’ll be back in the Vinyl Spooler window. To verify the scaling, again click on Cutter Scale and 
repeat the same steps. Make sure you leave your new scale factors in place by having the following 
option marked: 

 

 

◊ Once your test rectangle is drawing at the correct size, the calibration process is complete.  

 

 

  

Enter actual Width 
and Length 

Calculated Scale 
values 
 

Click on Update 
 

Leave this checked 
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2.09 Test Cutting Flow Chart for the Skycut 
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2.10 Settings Form for Cutting Materials 
 

Material Type 
Material Brand or 
Source 

Blade Force Speed  
Blade 
Offset 

# 
Passes 

Ht* Other Comments 

                  

                  

                  

                  

                  

                  

                  

                  

                  

                  

                  

                  

                  

                  

                  

         

         

         

 
 
*Number of Post-It notes used to set blade tip distance above material.  
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2.11 Suggested Cut Settings for Various Materials on  Skycut 
 

IMPORTANT: These settings should be used for the initial test cut. Adjustments may be necessary based on the condition of 
the blade, variations in the material, humidity, condition of the cutting mat, blade tip height*, etc. 
 
ALSO IMPORTANT:  Do not use a Blade Ht.* greater than 15 Post-Its with a blue capped blade. It is very fragile! 
 
* Blade Ht. = number of Post-It notes used to set blade tip distance above the material: Refer to Section 2.01.3. 
 
 

Material Type Material Brand/Source Blade Passes Force Speed
Blade 

Ht.*
Other Comments

Acetate 5 mil (0.13mm) R 1 45 (8) 400 20

Acetate
Apollo Inkjet Transparency 

Film (0.13mm)
R 1 60 (8) 400 20 Alt: 2 passes at Force = 40

Candle Wax Rayher: 0.025" (0.6 mm) B 1 20 (5) 250 15 Alt: Paper side up, Force 30

Candle Wax Stockmar: 0.05" (1.2 mm) B 1 25 (5) 250 10

Cardstock
AC Textured 216gsm, 80lb 

cover
R 1 60 (8) 400 20 Alt: 2 passes at Force = 50

Cardstock Bazzill Linen R 1 55 (8) 400 20

Cardstock
Carolina C2S Digital 144lb 

(234gsm)
R 1 75 (8) 400 20

Cardstock
Darice Core'dinations 

Premium (65lb)
R 1 45 (8) 400 20

Cardstock
Georgia Pacific, 110lb index 

(199gsm)
R 1 55 (8) 400 20 Alt: 2 passes at Force = 45

Cardstock Graphic 45 (0.22mm) R 1 50 (8) 400 20 6x6 Cardstock Pad

Cardstock Neenah Astrobrights 176gsm R 1 50 (8) 400 20

Cardstock Neenah Pastel 176gsm (65lb) R 1 50 (8) 400 20 Alt: 2 passes at Force = 40

Cardstock Recollections 176gsm (65lb) R 1 50 (8) 400 20

Cardstock
Recollections 176gsm (65lb) 

Kraft
R 1 55 (8) 400 20

Cardstock Wassau 176gsm (65 lb) R 1 50 (8) 400 20 Alt: 2 passes at Force = 40

Cardstock Worldwin Colormats (65 lb) R 1 50 (8) 400 20 Alt: 2 passes at Force = 40

Cardstock Worldwin Cutmates R 1 50 (8) 400 20 Alt: 2 passes at Force = 40

Cardstock Worldwin Smooth & Silky R 1 70 (8) 400 20 Alt: 2 passes at Force = 60

 
 

 
 
 

© 2018-2020 Sandy McCauley, All Rights Reserved 
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Material Type Material Brand/Source Blade Passes Force Speed
Blade 

Ht.*
Other Comments

Chipboard 0.022" (0.5 mm) R 2 100 (5) 250 20 Brayer well and tape edges

Chipboard Cereal box 0.018" (0.4 mm) R 2 100 (5) 250 20 Brayer well and tape edges

Chipboard 0.03" (0.76mm) B 2 120 (5) 250 15 Brayer well and tape edges

Chipboard 0.015" (.38mm) R 1 80 (5) 250 15

Construction Paper Creatology - pink R 1 30 (7) 350 20

Construction Paper Pacon Tru-Ray - black R 1 35 (7) 350 20 Alt: 2 passes at Force = 30

Craft Plastic
0.02" PET-G with blue 

protection sheets
B 2 130 (3) 150 15

Paper layer peeled off. Corners taped to 

mat

Craft Plastic Dick Blick; 0.015" (0.38mm) B 2 110 (3) 150 15
Paper layer peeled off. Corners taped to 

mat

Double Sided 

Adhesive
Sookwang R 1 60 (8) 400 20

Fabric - Cork embroiderygarden.com Y 2 50 (5) 250 15 Used an extra sticky mat

Fabric - Cotton Batik with Lite Steam-A-Seam 2 Y 1 65 (5) 250 20

Steam-a-Seam2 fused to wrong side, paper 

removed and sticky side pressed down to 

mat

Fabric - Cotton 

Flannel
with Lite Steam-A-Seam 2 Y 2 75 (5) 250 20

Steam-a-Seam2 fused to wrong side, paper 

removed and sticky side pressed down to 

mat

Fabric - Denim with Heat n Bond applied Y 3 115 (7) 350 20 Left paper layer on.

Fabric - Quilting 

Cotton
with Heat n Bond applied Y 2 65 (7) 350 20

Fabric - Quilting 

Cotton
with Lite Steam-A-Seam 2 Y 1 80 (5) 250 20

Alt: 2 Passes at Force = 70; Steam-a-

Seam2 fused to wrong side, paper removed 

and sticky side pressed down to mat

Foam (Fun Foam) Michael's 0.07" (1.8mm) B 2 20 (6) 300 10

HTV refer to Vinyl - Heat Transfer

Label Sheets: water 

resistent
Creative Label Concepts R 1 35 (8) 400 20 The Force is for kiss cutting the labels.

Leather 0.02" Bookbinding quality R 2 75 (7) 350 20

Leather ~ 0.06" B 2 100 (4) 200 10

Magnet 0.035" (0.9mm) B 2 120 (5) 250 10
Tape magnet to a sticky mat; may need 

slower speed for accurate shapes
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Material Type Material Brand/Source Blade Passes Force Speed
Blade 

Ht.*
Other Comments

Magnet
Printable Magnet Sheets 

(.25mm)
R 1 50 (8) 400 20

Magnet
Printable Magnet Sheets-15 

mil (0.4mm)
R 1 70 (8) 400 15 Alt: 2 passes at Force = 50

Mylar 5 mil (0.12mm) R 1 50 (8) 400 20

Mylar 10 mil (0.25mm) R 2 100 (5) 250 15 Extra sticky mat; tape corners

Mylar 7 mil (0.18mm) R 1 65 (8) 400 20

Paper - Copy Paper HP Everyday 20lb (75gsm) R 1 35 (8) 400 20

Paper - Watercolor
Canson 140lb (300g) Cold 

Press
R 1 100 (8) 400 20

Photo Paper HP Glossy R 1 80 (8) 400 20 Alt: 2 passes at Force = 65

Photo Paper
Royal Brites Matte White - 200 

gsm
R 1 70 (8) 400 20 Alt: 2 passes at Force = 55

Poster Board
Grocery store 0.013" 

(0.33mm)
R 1 70 (6) 300 20 Alt: 2 passes at Force = 60

Rhinestone Flock Sticky Flock R 2 45 (8) 400 20
Backing peeled and sticky side pressed to 

mat

Rhinestone Rubber Hartco 425S - green R 2 60 (8) 400 20
Backing peeled and sticky side pressed to 

mat

Shrink Film Grafix clear R 2 80 (6) 300 20

Shrink Film Grafix Ink Jet white R 2 120 (6) 300 15

Shrinky Dink Bright White R 1 125 (6) 300 20

Shrinky Dink Frosted Ruff N' Ready R 1 125 (6) 300 20

Shrinky Dink Printable Ink Jet white R 1 125 (6) 300 20

Stencil Blanks (also 

see Mylar)

Show-Offs 15 mil from Hobby 

Lobby
R 3 120 (5) 250 15

Place side with protection sheet down; tape 

corners

Styrene ASI .02" (.47mm) R 2 120 (8) 400 20

Styrene Evergreen .02" (.47mm) R 3 155 (5) 250 15

Styrene Plastruct .01" (.25mm) R 1 90 (8) 400 20 Alt: 2 passes at Force = 65

Vinyl - Heat Transfer Glitter Iron On - White R 1 30 (8) 400 20 Cut on mat
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Material Type Material Brand/Source Blade Passes Force Speed
Blade 

Ht.*
Other Comments

Vinyl - Heat Transfer Easy Weed - white, navy R 1 40 (6) 300 20 Cut on mat

Vinyl - Heat Transfer GlitterFlex Ultra - Black R 1 50 (8) 400 20 Cut on mat

Vinyl - Permanent
Expressions Vinyl 51 Series - 

Black
R 1 20 (8) 400 20 Cut on mat

Vinyl - Wall (no mat) Vinyl - Oracal 631 - yellow R 1 20 (8) 400 20 Not using a mat: note lower Blade Height

Vinyl - Wall (no mat) Vinyl - Oracal 631 - yellow R 1 25 (8) 400 20 Not using a mat

Vinyl - Wall (on mat) Vinyl - Oracal 631 - yellow R 1 20 (8) 400 20 Cut with vinyl on the mat

Wood Veneer
0.015" (0.4mm) from 

cardsofwood.com
B 2 100 (5) 250 15 Taped to mat; tested both oak and walnut
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3. Contour Cut (Print and Cut) 
 

 

3.00 Quick Reference for Chapter 3 

• How to calibrate the camera: Section 3.03.2 

• How to set up a contour cut: Section 3.04 

• How to add more registration marks: Section 3.08 

• How to speed up the scanning process: Section 3.04.3 

• Troubleshooting inaccurate PNC results: Section 3.06 

• How to set up repeats: Sections 3.07 (within contour cut window) and 3.10.1 (on main screen) 

• How to use QR codes in a contour cut application: Section 3.10 

• How to do a PNC from a USB flash drive file: Section 3.09.1 and 3.10.3 (with QR Code) 

• How to use the Array Mark function on the control panel: Section 3.09.2 
 
 

3.01 What Is a Contour Cut? 

• The contour cut process (also called print and cut or PNC) involves printing an image from SignMaster to 
any printer you own (or exporting as PDF) and then, with the aid of the Skycut’s camera, having the image 
or images cut out with perfect precision.  Below are three typical kinds of print and cut applications but there 
can be other kinds.  

◊ Cuts along the actual borders of the printed image(s): 

     

 

◊ Cuts outside of the borders but follows the shape(s) of the printed image(s): 

      

 

◊ Cuts follow a different shape from that of the printed image(s): 

Image is precisely cut along 
printed borders 

Image is cut in same shape 
but offset from the printed 
borders (contour cut) 
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3.02 What is a Camera Calibration? 

• In order to get precise results, you must calibrate the camera. This is nothing more than letting the Skycut 
know how far away the camera lens is located relative to the tip of the blade. Because the camera is 
manually installed inside the blade carriage, the distance from the camera’s center to the tip of the blade 
can vary slightly from one Skycut to the next.  

• This calibration only needs to be done one time. If you have travelled with your Skycut or it’s been bumped 
fairly hard, you might want to run a test to make sure your calibration hasn’t changed. It’s also 
recommended that you redo your calibration after any firmware updates are installed. 

• The process, which is conducted through the control panel involves: 

(1) Having the Skycut draw a test shape. At that point the camera takes a photo and displays it on the 

control panel, along with a red + and a large blue dashed +. 

(2) Aligning the red + with the center of the test shape display until the blue dashed + is centered with the 

test shape. 
 
 

3.03 Camera Calibration Procedure 

 

• You need the following items for this calibration: 

◊ Sheet of paper 

◊ Test pen that came with your Skycut 

(1) Insert the test pen into the Skycut. Place the sheet of paper into the Skycut. You can use the cutting mat to 
hold the paper or insert the paper directly. 

(2) On the control panel, move the test pen over the sheet of paper. 

(3) Select Speed/Force and set SPEED to ~ 8 and FORCE to ~ 30. Click on Test to verify that a square is 
clearly drawn. If it is too faint, increase FORCE as needed and repeat. 

(4) Move the pen an inch or two away from the test so that there is room for the calibration shape to be drawn. 

(5) On the Main Screen, press Set and then Camera: 

 

 

 

 

A custom shape is cut 
around the printed image. 
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(6) Press Adjust to switch to calibrate mode. Press and hold the OK button for several seconds until it and the 
arrows around it turn red:  

            

(7) Press Start. The test shape, which is a grid of 6 lines, will be drawn on the paper and the camera will move 
over the test shape, take a photo, and display the photo on the control panel. If you cannot see the test 
shape clearly, press the LED button once so that it reads LED 50% and press the Get PIC button. You 
should see three items in the photo: the test shape that was drawn with the pen, a red +, and the blue 
dashed +: 

 

 

 

 

Retake photo 

Update blue dashed + alignment 

This is where photo 
will be displayed 

Change brightness of LED light 

 

Adjust is calibrate mode 

Two different screens based 
on Align versus Adjust  Magnify photo by 300% 

Align is normal mode 

1. Select Adjust

2. Press and hold OK 3. Release after 
buttons turn red 4. Press Start 
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(8) Tap your finger near the middle of the drawn test shape on the screen. This will move the red + close to that 
location.  

  

(9)   Press OK. A new photo will be taken and one of two things will happen: 

◊ The red + is so close to the center that the Skycut will now take over and find the true center on its own. 
You will see the red + and the blue dashed + aligned in the center and the arrows (only) will return to 
their blue color. Refer to the left side of the next screenshot. 

◊ The red + and the blue dashed + are still not aligned and the arrows around the OK button are still red. 
Refer to the right side of the next screenshot.  You will need to tap the center again and press OK.  
Continue, if needed, until the center is identified. 

                        

Tap your finger here 
 

Red + 

Blue dashed + 

Red + is now much closer to the 
middle of the test shape 

Blue dashed + is also much 
closer to the middle of the test 
shape 

Not quite aligned 
– tap center again 

Everything is 
aligned with 
the center 

versus 

Arrows are 
blue again Arrows are 

still red 

Press Home 
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(10)  Once the alignment is in place and the arrows have turned blue, press the Home button and then press 
Stop on the Main Screen to save the calibration and conclude the process: 

 
 
 
   

3.04 Performing a PNC in SignMaster  
 

3.04.1 Summary of Steps 

• Here are the typical steps when performing a PNC application: 

◊ Prepare the image(s) that will be printed which can include the following: 

o An imported raster image such as a JPG or PNG or BMP file 

o A vector image (either imported or designed in SignMaster) that will be printed but not cut 

o Text that will printed but not cut 

◊ Prepare the cut lines which can include: 

o The resulting cut lines from tracing imported raster files. Refer to Section 5.01 for details on using 
the Trace function in SignMaster. 

o A contour cut around the outside of the traced image: Refer to Section 5.01. 

o Any other vector shapes, either imported or designed in SignMaster: Refer to Section 5.02.  

◊ Print the project, after selecting reg mark properties, location of project on the page, and printer options.  

◊ Perform a test cut so that you know the best cut settings to use for the printed material. This test cut can 
often be performed on the printout itself if there is room in the waste area of the project. 

◊ Perform the cutting process. 

 

3.04.2 Step-by-Step Simple PNC Project 

(1) While it’s not a requirement, it can be helpful in designing if the Drawing Area dimensions match the 

printout size you plan to use.  For this tutorial, Letter size (8.5” x 11”) will be used. But you can use much 

larger sizes, if you have the ability to print in those dimensions.  

(2) To change the Drawing Area, click on the down arrow to open a drop-down menu with many page options 

or just enter the dimensions directly: 

 

 

Press Stop
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(3) For a sample project, go to this link and download the zip. The project used in this tutorial is called Yellow 
Ox PNC. Alternatively, Section 5.01 presents a tutorial on importing a graphic and adding a contour cut. 

Note the contour cut around this image: 

       

(4) Click on the Contour Cutting icon  and select Contour Cut Wizard. The following window opens: 

           

(5) First, verify that Automatic ARMS is selected which means the camera will automatically scan the 
registration marks.  Registration marks will appear around the image. Next, to verify “what will print” versus 
“what will cut”, click on the other tabs below the preview:  

 

 

 

Click here to open 
menu of page sizes 

Or change the page 
dimensions directly here 

Blue line will be cut 
but not printed 

Yellow and black ox will 
be printed but not cut 

Select Automatic 
ARMS 

Preview of project 
with reg marks 
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(6) The following options are available for printing:  

 

◊ Print Direct – Select this option if you are printing directly from this window to your own printer. Note 
that the printer menu and printer properties appear to the right when this option is selected. 

◊ Print as PDF – Select this option to send the file to Adobe Reader to then print to your printer 

◊ Save as Image – Select this option to export your printout as a JPG or TIFF file using the DPI resolution 
of your choice  

◊ Save PDF – Select this option to export your printout as a PDF file to be saved and printed using a 
different computer/printer setup (such as taking to a professional printing company) 

(7) Optional: Before printing, click on the Print Options tab and the project can be centered onto the printout by 

clicking the Center button: 

 

 

◊ The shape is moved to the center: 

Print-only preview Cut-only preview 

Select the Print 
Options tab 

Click here to 
center the project 
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(8) Depending on the print option selected in Step (6), the print button below the Preview will vary. Assuming 

you selected Print Direct, you’ll see the option to Print. Click on it or click on the button in the same 

location and then complete any popup window options as needed. Note that if you’ve already printed your 

project, you will want to click on Skip instead: 

 

(9) Place the printout onto the cutting mat or load the printout directly if a cutting mat isn’t required.  Note that in 

SignMaster, a print and cut project is loaded “upside down” as shown in the following screenshot. On the 

printout is a small arrow which is a reminder to load the printout so that the little arrow is facing towards you 

as you are facing the Skycut:   

 

(10)  Load the mat and/or printout so that it is straight, relative to the cutter. The alignment doesn’t need to be 

absolutely perfect but close enough that it will allow for a faster and, of course, successful detection by the 

camera.  Insert the blade holder and perform a test cut, as needed, adjusting the cut settings.  

Before applying Center After applying Center 

Click on Print. Note: the 
wording on this button will 
vary based on print option 
selected in Step (6) Click on Skip if project 

is already printed 

Small arrow should 
point downwards 

Place printout this direction on mat or, 
if no mat is used, this direction as fed 
into Skycut 

Feed this direction into 
Skycut 
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(11)  Click on the Spooler and the Cut Options tab. If you want to send the cut settings from SignMaster, adjust 

the Force and Speeds accordingly or select a Preset. Otherwise, if using the cut settings on the Skycut 

control panel, turn these off. Click on Done after making any changes: 

 

   

        

(12)  Back in the Contour Cutting Wizard window, the Print button should now read Cut. Click on Cut and a 
new Preview window opens which indicates the design should be facing downwards: 

  

Click on Spooler to open the Vinyl Spooler window 

Make any necessary changes in this window 

Uncheck these options if settings 
on control panel will be used 

Click on Done to 
close this window 

Printout should be facing this way 

Set blade holder over lower right reg mark 

Click on Next 
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(13)  Click on Next and the Skycut’s camera will now move over each registration mark and take a photo and 
make an adjustment. Once it has read all four marks plus the first one a second time, it will proceed to cut 
out the printed shapes.   

(14)  After testing out this process, be sure to check out remaining sections in this chapter to understand 
additional options, such as: 

◊ Preparing a vector image for a PNC application – Section 3.05.2 

◊ How to set up a grid of repeats – two methods - Section 3.07 and Section 3.10.1 

◊ Adding additional registration marks to improve accuracy – Section 3.08 

◊ Performing a PNC using the USB flash drive – Sections 3.09.1 and 3.10.2 

◊ Using QR Codes to link a printout with a saved cutting job – Section 3.10 

◊ How to make the scanning process even faster – Section 3.04.3 
 
 

3.04.3 Two Timesavers: Fast Scan Mark and Extender Marks 

• Two extra functions provide a quicker way to perform contour cuts and should be of interest to you if you are 
in a production mode with your contour cutting projects: 

◊ Fast Scan Mark: On the control panel, go to Set>Advanced settings>System Mode. Mark the option 
for Fast Scan Mark and the camera will only take one photo at each mark instead of two or more 
photos: 

 

◊ An Extender Mark is a horizontal mark added to a contour cut printout and situated several inches (~ 
65 mm) to the left of the lower right registration mark: 

 

◊ After the first reg mark is identified the camera moves to the Extender Mark and takes a photo. It then 
compares the Y (up/down) location to that of the reg mark to determine if the two are in horizontal 
alignment with one another.  The Skycut’s firmware can then make a correction to take this into account.  

Enable Fast Scan Mark 

Extender Mark Lower right (first) reg mark 

The top of the Extender Mark is printed in 
alignment with the bottom of the first reg mark 
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◊ This results in fewer camera photo repeats if the printout is somewhat askew when loaded into the 
cutter.  

◊ To use this feature, first make sure you have L-shaped registration marks selected in the Contour 
Cutting Wizard window.  Then, on the Mark Options tab, enable the option for Use Extender Marks.  
The Preview will show the extender marks to be added to the printout: 
 

 

 

 

 

◊ The reason there are two Extender Marks printed is in the event you also use QR codes, which allow 
you to insert the printout either direction.  Refer to Section 3.10. 
 
  

3.05 Preparing Designs for PNC Applications 
 

3.05.1 Using Raster Images 

• Use File>Import>File to open a raster image (JPG, BMP, TIFF, PNG, etc) in Signmaster. To add a contour 
cut around this image, there are two options: 

◊ Add the contour while in the main Signmaster window – this process is covered in Section 5.01. 

◊ Add the contour after entering the Contour Cut Wizard window by clicking on Build Contours: 

 

o Using Build Contours essentially takes you to the same Create Cut–Contour window and the 
process is the same as presented in Section 5.01. 

• The advantage of tracing images before entering the Contour Cut Wizard window is the abilty to edit the 
tracing and save the file with the tracing in place. An example of editing a trace is covered in Section 5.01.2. 

 

Click here 

Select Mark 
Options tab 

Select Use Extender Marks 
Extender Marks printed at the top and 

the bottom of the printout. 
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3.05.2 Using Vector Images 

• You can design your own vector images in SignMaster using various design and vectorizing tools. You can 
also directly import vector files in a variety of common file formats including: AI, DXF, EPS, PDF, PLT, and 
SVG.  

• While vector images are essentially ready-to-cut files, SignMaster will not apply them as contour cuts in print 
and cut applications without having them assigned as such. Refer to Section 5.02 for instructions on how to 
perform a contour cut using a vector image. 

 
 
 

3.06 Inaccurate Cuts 

• There are several reasons why your print and cut results may not be as accurate as you need: 

◊ The contours around the printed image are not accurate 

◊ The cut settings are too aggressive 

• The following two sections present solutions for each of these.  

 

3.06.1 Inaccurate Tracings 

• When tracing imported images, the resulting cut lines may not necessarily follow the original image, 
especially in tight spots.  This can result in tiny bits of white appearing, suggesting the PNC wasn’t accurate.  
Zoom in on the image so that you can see the trace line following the outline of the image. Compare by 
looking at the same spots where the cut didn’t follow the image perfectly. This could be the cause of the 
inaccurate PNC.  There are several ways of handling this situation: 

◊ Retrace the imported image using a lower Smoothing setting (refer to Section 5.01). This will result in a 
tighter fit around the original graphic. 

◊ Use the Node EditingTools  to move the trace lines to more closely fit the original graphic. 

◊ Create an inset contour cut line to use for cutting instead of the original trace line. 

◊ Create a bleed by choosing Cutting Contour + Bleed in the Create Cut Contour window.  

• Another possibility is that the contour cut line was inadvertently shifted from the graphic to be printed. So, 
check to see if a misalignment may have occurred when you were moving or simply clicking on the design. 

 
 

3.06.2 Incorrect Cut Settings 

• If a PNC is not precise and the cause is not the calibration nor the alignment of the trace lines, then go 
through the following check list of other possible causes: 

◊ Try slowing down the speed.  If the mat is moving numerous times, in and out of the cutter, a slight 
shifting can occur, especially at high speeds. On the Skycut, try a speed of 7 or lower.  

◊ Verify that the pinch wheels are still centered over grit shafts beneath. 

◊ Make sure the blade isn’t over-extended which can cause it to cut too deeply and drag the cutting mat. 

◊ Make sure the bottom of the mat isn’t sticky and the pinch wheels and grit shafts are clean and not 
sticky. Clean with a lint-free cloth and a small amount of isopropyl alcohol or Un-Du. 

◊ If the print and cut project contains numerous repeats, use additional registration marks so that 
additional scans can occur during the cut.  Refer to Section 3.08 for instructions. 
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3.07 Adding Repeats in Print and Cut Applications 

• An array of repeats can be set up in the Contour Cut Wizard and this section will present the steps to do 
that. If you prefer to create the array in the main window of SignMaster, please refer to Section 3.10.1. 

(1) Create a design with the desired contour cut in place. In this tutorial, the same file is used as the one in 
Section 3.04.2, however the design has been resized to ~ 4.5” in height. 

(2) Click on the Contour Cutting icon  and select Contour Cut Wizard: 

 

(3) To add repeats, click on the Tiled Copies option and the Quantity settings will appear below that: 

   

(4) As you enter repeats, the Preview will update showing the copies and the overall project dimensions. If you 

need to size the project for a particular printout’s dimensions, mark the option for Print Direct so that you 

can verify whether or not the repeats will fit onto the printout. In this case, trying to fit 4 copies on a single 

Letter-size page will not work: 

Click on Tiled Copies 
to add repeats 

Enter rows and 
columns of repeats 

Enter desired spacing 
between repeats 
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(5) In this case, only two shapes will fit, so the Quantity is updated and the red margins and dimensions 

are now black: 

     

(6) Note that you have two options that can also be used, at times, to permit more copies to be printed: 

◊ Reduce the Mark Position setting, which is how far the registration marks are located from the printed 
shapes. More about this option and the Mark Options tab are covered in Section 3.08. 

◊ Reduce the size of the original by returning to the main window. This, of course, will work in some cases 
but not others. 

 
 
 
 

Select Print 
Direct 

Red margins and dimensions indicate project will 
not print with this number of copies 

4 copies 
selected 

Quantity reduced to 2 

Black margins and dimensions indicate 
project will print  
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3.08 Registration Mark Settings 
 

3.08.1 Adding Intermediate Registration Marks 

• Continuing with the same project from the prior section, to access the registration mark options, click on the 
Mark Options tab in the Contour Cutting Wizard window and note the following: 

 

 

◊ Set target mark spacing: use this option as a default or if you want to reduce the maximum spacing 
allowed between marks, thus increasing the number of marks. For example, if Vertical Mark Spacing is 
lowered to 100 mm, in this particular case, a new set of intermediary marks are added:  

 

 

◊ Specify number of marks: use this option to force another set of marks to be added: 

Select Mark Options tab 

Space marks based on 
distance 

Add more marks 

Lower spacing to 100 mm 
 

A new set of marks 
are added 
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• With these intermediate marks added, they will be scanned, as well. Thus, in this example shown, the 
bottom four marks will be scanned and the lower two shapes cut out. Then, the top set of four marks will be 
read and upper two shapes cut out. 

• IMPORTANT: Using the Array plus Array Mark options on the Skycut’s control panel allows for more 
flexibility when working with multiple registration marks, such as being able to only scan one mark when 
there are repeats. This is covered in Section 3.09.2.  
 
 

3.08.2 Registration Mark Types and Sizes 

• The dropdown menu next to Automatic ARMS contains 9 options for the type and size of registration marks 
that can be used: 

 

• There are two shapes available: 

◊ L - which is the right-angle type mark used in the screenshots so far in this chapter 

◊ CCD - circular dots 

Change from 1 to 2 
 

A new set of marks 
are added 
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• Note the following description and size for the individual options in the menu: 

◊ L-Shape: L marks that are 20 mm x 20 mm in size 

◊ L-Shape 20x9: L marks that are 20 mm x 20 mm in size. Any intermediate registration marks will be 20 
mm x 9 mm in size: 

 

   
 
 

◊ L-Shape 9x9: L marks that are 9 mm x 9 mm in size 

◊ CCD: circular marks that are 5 mm in diameter 

◊ CCD – 1mm: circular marks that are 1 mm in diameter 
 

 
 

3.08.3 Mark Position (Offset Distance from Design) 
 

• You can also change the offset or distance of the marks from the image. However, you also need to make 
sure marks are not too close to anything printed so that the camera doesn’t incorrectly attempt to scan the 
image instead of a registration mark: 

 

Distance of the marks from the 

outermost shapes 

 

L registration marks CCD registration marks 

L-Shape L-Shape 20x9 

Note that the 
intermediate marks 
will print over the 
image!  

The registration 
marks are clear of the 
image  
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• You can see the movement of the marks towards the image as the Mark Position is decreased. Because of 
the shape of the ox, this shouldn’t be an issue with the location of the registration marks relative to the 
printed image. However, if a design is more rectangular, such as a wine bottle label, then it is much easier 
to see that it could cause issues if the Mark Position is too small: 

   

 

       
 

 
 

3.09 PNC from USB Flash Drive 
 

3.09.1 PNC from Flash Drive – Single Cut 

• To perform a print and cut project from the control panel, first perform Steps (1) – (11) from Section 3.04.2. 
However, before clicking on Done to close the Vinyl Spooler window, click on the Connection tab and 
change the Port to U-Disk from the drop-down menu. Then click on Done: 

 

 

 

 

Mark Position = 0.307 in 

Should work 

Mark Position = 0.307 in Mark Position = 0.057 in 

Mark Position = 0.557 in 

Will work 

Mark Position = 0.057 in 

Will not work 

Mark Position = 0.557 in 
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• Back in the Contour Cutting Wizard window, proceed as before by clicking on Cut and the same Preview 
window opens and again indicates the design should be facing downwards: 

  

• Click on Next and the following window will open where you can save the job as a PLT file on a USB flash 
drive inserted into a port on your computer: 

 

 

 

Select Connection tab 

Select U_Disk 

Click on Done 

Printout should be facing this way 

Set blade holder over lower right reg mark 

Click on Next 
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• On the Skycut’s control panel, set the Force and Speed, if you elected not to have them activated in the 
Vinyl Spooler window in Step 11 in Section 3.04.2. 

• Go to Set>Camera.  With Align selected, press Set and the following window will open: 

    

◊ Verify that AutoMark box is checked. Then click on Home. 

• Insert the flash drive into the right side of the Skycut and use the instructions in Section 1.12.3 to open the 
file into the Skycut: 

 

1. Align should 
be red 

2. Then press Set 

Check 
AutoMark box 

Select the appropriate 
drive 

Name the file Click on Save 
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• Click on Start Cut and the marks will be scanned by the camera and the shapes cut out. 
 
 

3.09.2 PNC from Flash Drive – Using Array Mark for Repeats 

• The Skycut has the ability to set up an array of repeats for PNC applications. The advantage to using the 
Skycut’s control panel for this process is that the Array Mark function permits the scanning of additional 
registration marks as repeats are cut. This is far more accurate than only scanning the original four marks 
on significantly large projects: 

 

• The Array Mark window on the control panel can be opened in two ways: 

• Go to Set>Advanced Settings>Array>Array mark 

• Go to USB>Array Set>Array mark 

• In the Array Mark window, you have three options: 

• 4 Mark: Scan all four marks on every repeat 

 

 

Press Start Cut 

File name should 
appear here 

Reg marks 
printed around 
each repeat 

One set of reg marks 
on a large PNC 
project 
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• 1 Mark: Scan first four marks on first set only. Then scan one mark only on each remaining repeat 

               

 

• Alternate:  

       

 

 

    

 

 

 

Alternate between scanning all 4 
marks and scanning only 1 
mark, based on a set Interval 

Combination of 4 Mark 
and 1 Mark options 

Interval set to 1: 

1. Four marks in green set are scanned first and 
first three shapes cut. 
 

2. Single mark by orange arrow scanned, next 
three shapes cut. 

 

3. Single mark by purple arrow scanned, next 
three shapes cut 

 

etc. 

1. Four marks in green set are scanned first 
and first three shapes cut. 
 

2. Four marks in orange set scanned, next three 
shapes cut.  
 

3. Four marks in purple set scanned, next three 
shapes cut. 
 

etc. 
 

1. Marks in green set scanned and first three shapes cut.  
 

2. Single mark by the orange arrow scanned, next three shapes cut.  

 

3. Marks in purple set scanned, next three shapes cut. 

 

4. Single mark by blue arrow scanned, next three shapes cut. 

 

etc. 
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Interval set to 2                  

  

 

• When choosing an Array Mark option, keep the following in mind:  

• The purpose of having intermediate scans is to correct for any slippage that occurs due to friction or 
excessively fast cutting speed. 

• Use 4 Mark in situations where the repeats are quite large, thus there’s a larger distance between 
the repeats and slippage is more likely to occur. It’s also a good option when cutting thicker 
materials because the higher force applied by the blade can cause more drag on the material or 
cutting mat. 

• Use 1 Mark in situations where the material is thin, the cuts are simple, and the distance between 
the repeats is relatively small. Obviously, this is the most time-efficient choice of the three options 
since a 4 mark scan is only performed one time. 

• Use Alternate as a compromise between the other two options. Experience will determine how high 
of an Interval can still yield the accuracy you need. 

 
 

3.09.3 Mark Set Options 

• The Mark Set window has the following two applications: 

◊ Select a specific range of images to cut versus the entire project file. 

◊ While the cutting is underway, if you observe that the accuracy is off, you can immediately pause the 
cutter and tweak the calibration for just that particular cut. 

• To open the Mark Set window, press Mark Set on the USB screen: 

 

 

1. Marks in green set scanned and first three shapes cut. 

 

2. Single mark by orange arrow scanned, next three shapes cut. 

 

3. Single mark by purple arrow scanned, next three shapes cut. 

 

4. Marks in blue set scanned, next three shapes cut. 

 

etc. 

NOTE: If your screen does not 
have Mark Set displayed, please 
go to Appendix B for activation 

instructions. 

Press Mark Set 
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• To select a specific range of images, note the following: 

◊ The first set to cut is referred to as M0 and then subsequent sets are M1, M3, M3, etc. 

◊ In the Mark Set window, select Custom and then enter the start and ending sets. For example, if you 
want to start with the second set and end with the seventh, you would change to M2 and M7: 

     
 
 

◊ The resulting sets will be sent versus the entire project: 

 
 

• To tweak the calibration after a cut has begun: 

◊ Press the Pause button on the Home screen to immediately stop the cutting. 

◊ Press the USB button on the Home screen. 

◊ Press the Mark Set button. 

◊ Check or uncheck the adjust Immediately option based on the following: 

o Check the option if you want the adjustment to be made on the current shape that was being cut 
when you paused the Skycut. Note that the start and end point on that path will not completely 
close, as a result. 

o Do not check the option if you want the adjustment to be applied on the next shape that will be cut.  

◊ Click on the arrow buttons to adjust the Δx and Δy by the amount and in the direction you need the cut 
line to move: 

Select Custom 

Default settings 

Select + and – 
buttons to change 
start and ending sets 

M7 

With M2 and M7 
entered, these sets will 
be cut 

M6 

M5 

M4 

M3 

M2 

M1 

M0 
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◊ Once you have entered the Δx and Δy values you wish to use, press the Go on button and the cutting 
will resume. 

• Important:   

◊ If you need to make yet another adjustment, repeat the process.  The new Δx and Δy you enter is only 
an adjustment based on what you are now needing. For example, based on this example, if you need Y 
to move another 0.2 mm in the same direction, you would enter 0.2, not 0.4 mm.  

◊ Remember that the adjustment is reset at the conclusion of the cut.  
 
 
 

3.10 Using a QR Code in Contour Cutting 

• SignMaster has the ability to add a QR code to a printout, which identifies a timestamp assigned by 
SignMaster. This QR code can be used when sending the cut directly from SignMaster or when using a PLT 
file from SignMaster with the QR Code option enabled.  

• To activate QR code usage on the Skycut, go to Appendix B and use the command procedure for adding 
the QR Cut button to the USB screen: 

 
 

 

Adjustments to be 
made to cut line 

Click the arrow buttons to move the 
cut line in the direction needed. 

Cmd code 041 will add QR 
Cut to the USB screen 

(Appendix B) 
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3.10.1 Setting Up an Array of Repeats  

• The QR Cut process involves enabling a Page Marks setting which will be covered in Section 3.10.2. At the 
time of this writing, SignMaster Pro 3.5 does not allow Tiling in the Contour Cut Wizard window when this 
setting is used.  Therefore, if you need to set up an array of repeats, please use the following method 
instead:  

o In the main window, set the Drawing Area to match the printout dimensions you’ll be using. 

o Import (or design) the image for the contour cut. Add a contour cut for your raster or vector image. 
Refer to Section 5.01 or 5.02 for instructions. Arrange the traced design in the upper left corner of 
the Drawing Area: 

 

o Select the image and its cut line and go to Arrange>Tile Array tools: A new window opens with 
options for the number of rows (Horizontal) and columns (Vertical) and their corresponding 
spacing: 

                           

  

• Note that the raster images will not appear as you create the repeats, but will appear in those repeats upon 
clicking on Apply.  At this point, the original image isn’t part of the overall selection so use Ctrl+A (or 
Edit>Select All) to ensure everything is selected and then drag to the approximate middle of the Drawing 
Area (this seems to work better, at this time, than using Center inside the Contour Cut Wizard):  

Image is traced and moved 
near the upper left corner 

Click Apply 
when done 

Spacing between 
columns  

# columns 

# rows 

Spacing between 
rows 
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3.10.2 QR Code Cutting Directly from SignMaster 

• Open the Contour Cut Wizard window. Click on the Page Marks option and mark the box by QR Code.  
The Preview will now show symbols for the QR code and for the timestamp: 

  

◊ You’ll notice that when QR Code is enabled, a second option called (x2) and the assigned timestamp 
appear to the right of the QR Code option: 

 

 

Timestamp QR code added 

Select Page Marks 

QR code 
added 

QR Code 
enabled 

Drag to the ~middle of the 
Drawing Area 

Use Ctrl+A to select everything 

Enable QR Code 

timestamp 

Print QR Code at top and 
bottom of printout 
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◊ Printing the QR code at both the top and the bottom of the printout means you can position the printout 
either way in the cutter: 

          

o Even though the following Preview (when using the (x2) option) indicates the printout needs to 
be positioned in this orientation, you can have it rotated 180 degrees and it will still cut correctly 
because the QR code contains a symbol indicating which orientation is being used: 

               

 

 

 

◊ You have the option at this point of proceeding with the normal process of printing and cutting from 
SignMaster.  If everything is working correctly, after the first lower right registration mark is identified, the 
camera will stop at and scan the QR code before proceeding with the cut. 

◊ Alternatively, you can print now but perform the contour cut at any point in the future from this same 
computer by having the cut file created and stored in the Vinyl Spooler. To do this, after printing (or 
exporting as a PLT file), click on Done and the following window opens: 

   

(x2) enabled: the QR code 
is also printed here 

(x2) disabled: QR code 
is only printed at the top  

versus 

(x2) enabled: two QR codes and the printout 
can be inserted this way or rotated around 

(x2) disabled: only one QR code and the 
printout must be inserted this way  

versus 

Click on Yes to have cut file 
added to the spooler 

Click Done  
(instead of Cut) 
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◊ By clicking Yes, this file (with the timestamp as part of the Job Name) is added to the Vinyl Spooler 
window and at any point later on, after one or after many other cuts from SignMaster, you can activate 
this cut by doing the following: 

o Insert the printout into the Skycut and arrange the blade holder over the lower right registration mark 
(as per usual). 

o In SignMaster, go to the Vinyl Spooler and click the QR Code icon in the bottom right portion of the 
window: 

 

o The camera will immediately move to the left to read the QR code and select the correct job from 
the Spooler menu by finding the matching timestamp. The rest of the scanning and contour cut will 
proceed.  

◊ If you wish to return to regular contour cutting in SignMaster (i.e. not have the camera stop and look for 
a QR code), remember to deactivate QR Cut on the Skycut’s control panel using the same procedure 
presented in Appendix B.  

 
 

3.10.3 QR Code Cutting from a PLT File 

• Follow the same procedures presented in Sections 3.10.1 and 3.10.2 to set up the contour cutting file.  Also 
use the same procedures present in Section 3.09 to export your file in PLT format.  

• However, when the Save Plt File window opens, the timestamp will automatically appear in the File name 
field.  IMPORTANT:   

◊ Use this timestamp as the file name so that the Skycut will be able to pull up this file based on reading 
the QR code on the printout. 

◊ It is highly recommended that these files be saved in the root directory of the flash drive versus inside a 
subfolder.  By doing so, the file will be automatically located when the QR Code is read. 

 

 

• Load the flash drive into the Skycut.  Insert the printout into the Skycut and arrange the blade holder over 
the lower right registration mark (as per usual). 

Click on QR Code icon 

Click on Save to accept this 
file name The timestamp will 

automatically appear here 

Browse to find 
USB flash drive 
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• In the USB window, you may wish to mark the option for Search Root Dir in case the Skycut has already 
been used to open files in a subfolder on the flash drive: 

 

•   Click on QR Cut and the camera will  

(1) Read the first registration mark.  

(2) Move to the QR code to read the timestamp.  

(3) Locate the file on the flash drive with that same timestamp as its name. 

(4) Proceed with identifying the rest of the marks and perform the contour cut. 

• As mentioned in Section 3.10.2, if you wish to return to regular contour cutting in SignMaster (i.e. not have 
the camera stop and look for a QR code), remember to deactivate QR Cut on the Skycut’s control panel 
using the same procedure presented in Appendix B.  

  

Mark this option 

Click on QR Cut 
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4. Accessory Tools 
 
 
 

4.00 Quick Reference for Chapter 4 
 

• Settings for test pen, embosser, engraver: Section 4.05 

• How to draw with the test pen and cut around the drawing: Section 4.01.1 

• How to score and cut a fold-up project: Section 4.02.2 

• How to emboss cardstock: Section 4.02.3 

• How to engrave a metal tag: Section 4.03.1 
 
 

4.01 Drawing with the Test Pen 

• With the Skycut, you can draw shapes and lettering with the test pen. 

• If you wish to fill (i.e. color in) a shape, select the shape and click on the Plugins icon  and select 
Engraving Module. Refer to Section 5.03 for instructions on how to adjust settings to create a line fill. 

• Do not have the pen positioned too low in the blade holder seat or the tip of the pen could drag across the 
paper when moving from one shape to the next.   Thus, use the same 20 Post-It note method as with the 
blade holder. 

• Make sure your shapes will not be drawn where any of the pinch wheels travel over the material. Otherwise, 
the ink might smear.  

 
 

4.01.1 Draw and Cut 

• A draw and cut application involves using the test pen to draw shapes and then using the blade holder to cut 
them out.  This rest of this section covers the process.  

• In the following example, a design is selected from General Clipart and sized for the project. Then a 
contour is added using the instructions in Section 5.01: 

 

• Note that the contour color (blue) differs from the design’s Fill color (black). This is important so that the 
draw and cut can occur separately, providing the opportunity to change out tools. 

• Click on the Cut, Plot, & Engrave Tools icon and select Send to Cutter. In the Send to be Cut window, 
mark the option for Assign Tools by Color. You will then see the two colors, blue and black, appear in the 
Cutting Tool Presets list: 
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• The layers will be processed in the order shown. However, because it makes more sense to draw first and 
cut second, the blue layer will be moved down. This is done by selecting the blue layer and clicking on the 
down arrow below: 

 

• The cut settings for each layer now need to be assigned. If settings have already been entered and saved 
as Presets, you only need to select from the Preset menu: 

 

• If you need to enter new settings, which will be done for the contour cut (blue) layer, select that layer and 
click on Edit and the following window opens: 

 

Mark this 
option 

Colors used in 
project 

Click the down 
arrow 

Select blue 
layer 

Click the down arrow to 
open Presets menu 

Select black 
layer 

Select Pen Mode 
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◊ IMPORTANT: Note that this window does not allow you to save the settings as a new Preset. Thus, if 
you will be cutting this material often, you might prefer to set up a preset for it using the instructions in 
Section 2.04.2. 

• After clicking on Apply, you will see that both colors now have settings assigned. Because the blue layer is 
still selected, its settings show along the bottom: 

 

 

• Load the material into the Skycut. Click on Cut Now and you will be prompted to load the Pen Tool: 

 

3. Enter all settings to 
be applied for this cut 

1. Select blue 
layer 

2. Click on 
Edit 

4. Click on Apply 

Blue layer is selected 

Assigned settings 
for blue layer 

Both layers have settings assigned 
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• Load the test pen into the Skycut, click on OK, and the design will begin drawing.  The second prompt 
window will immediately open: 

 

• As soon as the drawing process has ended, load the blade holder into the Skycut and proceed with the 
contour cut by clicking on OK in the prior window. Once completed, click on Done to close the Send to be 
Cut window. 

 

 

This prompt 
window opens 

2. After loading test 
pen, click on OK 

1. Click on Cut Now 
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4.02 Embossing and Scoring 
 

4.02.1 General Info on Embossing 

• The Skycut embossing tool has two different sized embossing heads. The smaller one is recommended 
when scoring cardstock for fold-up projects, such as pop-up cards, gift bags, and small boxes. Either head 
can be used for embossing shapes. 

 

• When embossing cardstock, it is recommended that a soft material be place beneath the paper or cardstock 
to allow a deeper impression to be made. One excellent material to use is non-slip shelf liner.  Other 
materials which can be used include rhinestone rubber, craft foam, and felt. Make sure the material is well 
adhered to the mat (tape it down, if necessary). Then tape your paper or cardstock to the top of this 
material. 

• When using the embossing tool for scoring fold-up projects, the paper or cardstock can be applied directly to 
the mat, just as you do for cutting. This makes it much simpler when you need to score and then 
immediately cut. Because the scoring may not be as deep on the underside of the paper or cardstock as the 
top side, fold all score lines (valley and mountain) forward to establish the fold on both sides. Then flip over 
and fold any mountain folds the opposite way. This especially works well on pop-up cards. 

• Make sure you do some tests first to get the best settings for the scoring or embossing you need.  For 
scoring cardstock, this typically involves a higher force (~160) and two or three passes.  Refer to the 
Suggested Settings table at the end of this chapter. If you have a soft material beneath your 
paper/cardstock, then a lower force will be used, but you may still need several passes. Also, to get more 
force applied, raise the tool in the blade holder seat the same way you do with the blade holder (i.e. 20 Post-
It notes). 

 

4.02.2 Score and Cut Project  

• When a project involves both scoring and cutting, the process used in Section 4.01.1 cannot be followed.  
This is because scoring normally requires multiple passes in order to get acceptable folds and the Passes 
setting does not currently work if the Assign Tools by Color option is in use. Thus you most likely will need 
to do the two processes separately. 

• In this tutorial, a fold up box project will be used as a typical example. This small box file is provided in the 
zip file available here. 

 

• Always make sure the project is organized so that you can easily select the score lines and the cut lines 
separately.  Click on the Objects tab on the Page Thumbnail Viewer and verify that the project is 
organized as such. In this example, the score lines have been grouped together and the cut layer is just a 
single object:  
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• Because Absolute (position) will be needed to make sure the score lines and the cut lines end up aligned 
properly, you may want to move your project to the lower right corner of the Drawing Area, close to the 
origin you’ll use on the material: 

    

• Click on the thumbnail for the score lines since that layer should always be executed first. In the Send to be 
Cut window, check Absolute (position) and verify that Assign Tools by Color is not marked: 

 

• Click on the Cutter Control tab and enter appropriate settings for scoring your material. In this case, 
cardstock is being scored:  

 

Cut lines are on one layer 

Score lines are on another layer 

Check the box for Absolute 
(position) 

Uncheck the box for Assign Tools 
by Color 

Uncheck Blade 
Offset 

Enter settings for scoring 

Set Passes for scoring 
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• Note that if you will be performing score and cut projects regularly, setting up a Preset for your material will 
make the selection of the settings much faster. Refer to Section 2.04.1. 

• Load the material into the Skycut and load the embosser with the small end downwards into the Skycut. 
Move the embosser to an appropriate origin. Click on Cut Now. 

• After the scoring is complete, select the thumbnail for the cut lines and repeat the process. Remember to 
turn on Blade Offset in the Cutter Control window and switch out the embossing tool for the blade holder.  

 
 

4.02.3 Embossing Paper or Cardstock 

• When embossing paper or cardstock, it is recommended that you use an Outline effect to create several 
very small outlines at a thickness of, say, 0.01” (0.25 mm). These tiny offset lines will then produce a slightly 
thicker overall outline of your shapes. This works better than line-filled embossing which can stress the 
cardstock and cause wrinkling. Here are the steps: 

◊ Create the shape you wish to emboss. In this example, the number 25 is used: 

 

◊ Select the shape and click on the Plugins icon  and select Outlining Module. The following 
window opens: 

 

  
 

◊ After clicking on Accept, use the Objects panel to select the new outline layer and repeat the process 
to add a second outline. Now you have three versions of the shape, each one slightly outset from the 
other.  Thus, when using the embossing tool, this will result in a thicker outline made of this shape.  

◊ Important: don’t forget to mark the Mirror option in the Send to be Cut window (or apply 
Arrange>Mirror & Rotate>Mirror Horizontally) so that when you flip over the cardstock after 
embossing, the design will “read correctly.”  

 

Set Size to 0.01” 

Click on Accept 
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4.03 Scratch Engraving 

• The Skycut engraving tool can be used to engrave vellum, foils, acrylic, and most metals, including trophy 
labels, dog tags, and jewelry charms. 

 

• On softer metals, you may not want the engraving tip too far above the metal as it can leave pock marks 
when it drops to start engraving. If possible, test on scraps first. 

• Refer to the Suggested Settings table at the end of this chapter for Force and Speed settings on various 
materials. Note that in some cases you may want to use more than one pass for a deeper engraving. 

• To design an engraving fill pattern, use the Engraving Module. Refer to Section 5.03  

 

4.03.1 Engraving a Metal Tag 
 

 

• When engraving items that are already cut (such as metal tags, trophy plates, charms, etc.), it’s very 
important to have precise alignment before proceeding.  Therefore, the camera on the Skycut will be used to 
set the origin for engraving. If you haven’t already calibrated the camera, go to Section 3.03. 

• The following is a list of the items you’ll need for this kind of an application: 

◊ The item to be engraved 

◊ The Skycut engraving tool 

◊ Double sided tape to secure the item to the cutting mat. Thermo-web is perfect for this. 

• Create a replica of the item to be engraved: 

◊ If it’s something simple, like a square or a rectangle, use the basic shapes available in SignMaster: 

          

◊ If it’s not a shape that can easily be recreated in SignMaster, then trace it onto paper: 

 

◊ Scan or photograph the trace and use the instructions in Section 5.01 to import the scan and create a 
contour of the heart: 

Photo of actual tag Replica of tag created 
using two circles 
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• IMPORTANT: Carefully measure the actual tag and compare it to the dimensions of the contour. Adjust the 
size of the contour if needed. 

• Create the design. In this case both text and a vector shape of a bone are added: 

 

• Because a filled engraving is desired, select the text and the bone shape and use the Engraving Module to 
fill the design with lines.  Details on this function are presented in Section 5.03.  

 

• To arrange the design in the bottom corner of the Page, click on Snap in the middle taskbar and select 
Page: 

 

• With both the heart and the design selected, drag to the lower right corner until it snaps to the right and 
bottom sides of the Page / Drawing Area (Note: to better illustrate placement on the page and later in the 
Preview, the design has been made much larger. In reality the design is only about an inch in size): 

 

• Select only the design and not the heart tag shape. In the Send to be Cut window, mark the option for 
Absolute (position) so that the design will be positioned the same distance from the origin as it is from the 
corner of the Page / Drawing Area.  Also, verify that Assign Tools by Color is not marked: 

Imported scan Tracing from Create 

Contour Cut window 

Mark Page 

Snap the design to the lower 

right corner of the page 
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• Click on the Cutter Control tab and enter the settings for engraving: 

 

 

• On the Skycut, the metal tag needs to be very firmly attached to the cutting mat. Place strips of double-sided 
tape onto the mat, where the tag will be mounted: 

 

• When placing the tag onto the mat, align the rightmost side of the tag with a vertical grid line and the 
bottommost side of the tag with a horizontal grid line. The intersection of the two gridlines will be the origin 
for the engraving process: 

Double sided tape is placed on the 
mat to cover the size of the tag (note: 
the pink liner hasn’t yet been removed 
from the top of the tape) 

Check Absolute (position) 

Design is in same location 

as on the Page 

Verify Assign Tools by 

Color is not checked 

Uncheck Blade Offset 

Change to settings 

for engraving 
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• Load the mat into the Skycut and be very precise in alignment by using the cutting strip to make sure the 
mat is perfectly straight on both sides: 

      

• Load the engraver into the Skycut using 15 Post-It notes, making sure the notes are on top of the tag.  

• Move the cutting head so that the engraver tip is over the intersection of the two grid lines bounding the tag. 
Then use the camera instructions in Section 2.05.1 to set the origin even more precisely by getting the blue 
dashed + in the middle of the grid intersection: 

 

• After clicking on Home, press down on the engraver and verify, once more, that the correct grid intersection 
was used. Back in SignMaster, click on Cut Now and the engraving process will be carried out.: 

 
  

Align the tag with the grid 
lines on the mat 

The origin will be set at this intersection 

Blue dashed lines cross at 
grid intersection 

Align the mat on both sides 
with the cutting strip 
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4.04 Settings Form for Accessory Tools 

 

Application/Material Tool Force 
Speed 

(Cut/Up) 
# 

Passes 
Surface Other Comments 

              

              

              

              

              

              

              

              

              

              

              

              

              

              

              

              

              

© 2009- 2020 Sandy McCauley, All Rights Reserved 
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4.05 Suggested Settings for Various Accessories1 

 
 
 
 
 
 

 

Application/Material 
Tool 
Used 

Passes Force Speed 
Tool 

Height 
Surface Other Comments 

Drawing on Cardstock Test pen 1 30 
(11) 
550 

20 mat 
  

Embossing Cardstock 
- 65 lb (177 gsm) 
Recollections 

Embosser 
- large 

end 
4 80 

(6) 
300 

10 

Shelf 
Liner 

taped to 
mat 

Used 2 shadow layers of 0.01" 
(0.25mm) to increase thickness; 
also tested Fun Foam taped to 
mat with same results 

Engraving Acrylic 
Scratch 

Engraver 
1 110 

(8) 
400 

20 mat 
Used a Line Fill of 0.004" (0.1 
mm) 

Engraving Aluminum 
(36 gauge) 

Scratch 
Engraver 

1 20 
(11) 
550 

15 mat 
Used a Line Fill of 0.004" (0.1 
mm) 

Engraving Copper (36 
gauge) 

Scratch 
Engraver 

1 30 
(11) 
550 

15 mat 
Used a Line Fill of 0.004" (0.1 
mm) 

Engraving Metal Tag 
(Al) 

Scratch 
Engraver 

1 44 
(9) 
450 

15 mat 
Used a Line Fill of 0.004" (0.1 
mm) 

Engraving Vellum 
Scratch 

Engraver 
1 38 

(11) 
550 

15 mat Vellum was medium weight 

Scoring Cardstock - 
Georgia Pacific 110# 
index 

Embosser 
- small 

end 
2 155 

(8) 
400 

20 mat 
  

 
 

  

Make sure Blade Offset and Overcut are set to 0; test with a small shape first; mirror shapes for 
embossing. 
 
Tool Height = number of Post-It notes used to set blade tip distance above the material: Refer to Section 
2.01.3. 
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5. SignMaster Functions of Interest 
 
 
 

5.00 Quick Reference for Chapter 5 
 

• How to add a contour cut: Section 5.01 

• How to node edit a contour: Section 5.01.2 

• How to add a contour cut to a vector image: Section 5.02 

• How to fill a design with engraving lines: Section 5.03 
 
 
 

5.01 Adding a Contour Cut Line to an Imported Raster Image 

• Graphics such as JPG, PNG, and BMP files are often used for print and cut (contour cut) applications. 
Because these types of files are raster images (versus vector images), the images must be traced. This is 
done through a process called vectorization.  

5.01.1 Step-by-Step Tracing Process 

• The following steps are a sample tutorial using the Create Contour Cut feature in SignMaster: 

(1) For this project, go to this link. After extracting, you will find several images that can be used as easy 
samples for tracing.  

(2) To import a graphic file, go to File>Import>File and select the graphic to be traced. Left click anywhere 
in the Drawing Area to place the image: 

 

(3) With the graphic selected, click on the Contour Cutting icon  and select Create Cut Contour. A 
popup window will open and you will respond Yes: 

 

(4) The Image Contour Tracer window displays the various settings available for adding a cut line to the 

graphic: 
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(5) Without making any changes, click on the Trace button to get a preliminary trace which will indicate 

which settings, if any, need adjustment. The blue line indicates what will cut based on the default 

settings shown: 

 

(6) To see the trace line a little more clearly, adjust the Opacity setting at the top. If the “fit” isn’t tight 
enough, decrease the Smoothing setting. After making changes, click Retrace to return to the original 

tracing window and then click on Trace again: 

 

 

Click here to trace at 
current settings 

Carefully check blue cut line: 

• Are all needed parts 
traced? 

• Is trace line a tight enough 
fit? 

 

Decrease Smoothing 
for a tighter trace line 

Increase Opacity to better see blue trace line 

Option to trace internal 
parts if needed. Refer to 
Section 5.01.2. 
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(7) After making any changes, click on Retrace at the bottom of the screen.  On the other hand, if you are 
happy with the trace results, click on Apply: 

 

 

(8)  If you selected Retrace, a Composite view of the results will appear where blue indicates the part that 

will be cut out and red indicates the waste material.  You can go back to seeing the prior view by 
clicking on the Original tab at the bottom. Click on Trace to apply the new settings.  

 

 

(9)  After clicking on Apply, a new group of settings appear, giving you additional options such as: 

◊ Whether the cut line is continuous or perforated 

◊ Whether the cut line fits the image tightly, or is offset a distance or inset a distance 

◊ Whether internal cut paths should be removed 

◊ The cornering shape of the contour cut (rounded, beveled, mitered, etc.) 

Click on Apply if satisfied 
with existing trace  

Click on Retrace to 
adjust to new settings 

Click on Trace  
 

Alternate viewing 
options 
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◊ Choose a Corner Style, as desired. For the Outline % or Outline Units (size), note the following: 

o Set to 0 if the cut line should align with the edges of the printed image 

o Set to a positive number for a contour cut around the outside of the printed image 

o Set to a negative number (normally very small) to cut slightly inside the printed image 

(10)  Click on Accept after making any changes and you will be returned to the Drawing Area. If you click 
on the Objects tab on the Page Thumbnail Viewer, you will now see both the original image and the 

contour cut line: 

    

• To print and cut this type of design, refer back to Sections 3.03 and 3.04. 
 
 

Contour shape options 

Contour type options: use 
these settings 

 
 

Click on Accept when done 

Original image options 
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5.01.2 Editing a Trace 

• Occasionally you may find a need to edit the tracing/contour cut created. This section presents two 
examples. 

• Contour cut doesn’t fit the original graphic in certain spots 

◊ In the following example, the Cartoon Owl image will be used: 

 

◊ During the process of tracing, it was found that the bottoms of the owl’s feet weren’t rounded like in the 
original image. Even trying different adjustments to Smoothing didn’t result in the desired fit. Note that 
a slight inline was applied to improve the accuracy of the fit but the bottom of the feet still need 
tweaking: 

 

◊ With the trace line selected, click on the Node Edit Tools icon  and the nodes making up the path 
of the cut will appear.  Drag nodes, as needed, so that curves are formed: 

 
 

• Contour cut contains paths you want deleted 

◊ In the following example, a crab cartoon from Doodle Dragon Studios is traced: 

 
 

◊ The issue in this example is that the space below the eyes should be cut out but not other internal 
shapes, such as the pupils of the eyes. Note the difference in what will be cut between marking and not 
marking the Keep Holes option in the Create Cut-Contour window: 

Trace line is flat along the bottom of owl’s feet 

Drag nodes to create curves 

An outside trace is 
needed 

Also needed is a trace of 
this area between the eyes 
and the body 



 133 

      
  

 

 

◊ The first option, Keep Holes, needs to be selected so that the area beneath the eyes is traced. After 
accepting the trace, click on the Objects tab on the Page Thumbnail Viewer and hide the original 
graphic. You will now only see the contour in the Drawing Area: 

           

 

◊ Select the contour and go to Curves>Break Apart. The individual paths will now be separate layers on 
the Objects tab and you can delete each one that is not needed: 

 

     

Keep Holes not 
checked 

Area below eyes is traced but so 
are the inner parts of the eyes 

Keep Holes 
checked 

No inner paths at all 
 

versus 

Delete these 
three layers 

 

Paths inside of the 
eyes are gone Path below eyes is 

part of the contour cut 

Select this layer and 
click on Hide icon 
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5.02 Adding a Contour Cut to a Vector Image 

• As mentioned in Section 3.05.2, vector images require a contour cut assignment in print and cut 
applications. For example, the following Batman SVG file is imported into Signmaster and then the Contour 
Cut Wizard window is opened. Note that comparing the View Print only preview with the View Cut only 
preview indicates that the vector file is ready to print but there’s no cut line for the design: 

   

 

• There are two situations to consider: 

◊ A contour cut will be added to follow the printed design (Section 5.02.1) 

◊ A contour cut will be added and it will be offset from the printed design (Section 5.02.2) 

 

5.02.1 Contour Cut Which Follows the Printed Design 
 

• Upon importing the SVG file, open the Objects tab of the Page Thumbnail Viewer to display the various 
shapes in the file: 

      
 

What will print What will cut Option to add contour cut 

Click this blue 
arrow 

Click the Objects tab 

All of the shapes 
appear in a list 
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• From the Objects list, click on the shape which represents the contour cut line you wish to use. In this 
example, it is the black shadow layer: 

 

• With that layer selected, go to Edit>Duplicate. A new layer will appear at the bottom at the Objects list and, 
thus, will now be arranged on top of the project: 

 

• This new layer will also be selected.  To assign it as the contour cut, click on the Custom Fill icon 
that is located on the Palette and select Cut Contour from the drop-down menu: 

     

• This newly assigned contour cut layer is given an invisible fill color and will no longer appear on top of the 
imported project. 

 

• If you now go to the Contour Cut Wizard, you can verify that this new cut layer exists on the View Cut 
Only tab: 

 

Select this layer 
 

Click here 
 

Select Cut Contour 
 



 136 

 

 

 

 

5.02.2 Contour Cut Which Is Offset from the Printed Design 

• This section presents the method to be used when the contour cut is not one of the existing vector shapes. 
While this section accesses the Create Cut-Contour window from within the Contour Cut Wizard window, 
note that the same process can be applied by adding the contour from the main screen as was done in 
Section 5.01 (i.e. select shape and go to Contour Cutting>Create Cut Contour). 

• In the earlier screenshot, SignMaster recognizes there is no contour to cut on the View Cut only tab and 
offers the option to add one using the Build button below the preview. 

    

 

◊ Clicking on Build opens the Create Cut–Contour window: 

 

What will cut Option to add contour cut 

What will cut 

Contour cut layer 
now appears 
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o Corner Style: Usually select either Round or Sharp depending on the nature of the original vector 
and your desired contour 

o Outline (%) or Outline (Units): Enter either a percentage or the actual size for the outline. In the 
prior screeshot, leaving the Outline at 0 results in the contour being the same as the original 
outside vector line. This would result in the same contour cut as was created in the prior Section 
5.02.1. For an outset cut around the printed image, increase Outline to the desired size. For in inset 
or inline cut, decrease Outline slightly so that it’s a negative number: 

 Outline is set to 1/8 (0.125) inches: 

       

 

 Inline is set to -1/32 (0.03) inches: 

 

 

 

 

 

Select a Corner Style 

Click on Accept when done 

Use these options 

Keep at 0 for cut line 
to follow print line or… 
Increase to add a 
contour cut or… 
Decrease to add an 
inset cut 

Click on View Mode to add the Outline preview 

Outline set to 0.125” 

 Blue line shows size of 
contour around original 
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◊ After clicking on Accept, the View Cut only preview now indicates a cut path exists and you’re ready to 
proceed: 

 

• Note that text is also a vector shape, thus the contour cut on a text object would be created the same way.  

• Also note that there is a Keep Holes option in the Create Cut-Contour window which controls whether or 
not the contour is a solid outside cut or contains internal cuts following the shape of the vector: 

◊ Keep Holes not marked: 

 

◊ Keep Holes marked: 

 

Outline set to -0.03” 

 Blue line shows size of 
inline inside of original 

Leave unchecked 

 A single blue line will 
be cut around the text 

What will cut 

Contour cut layer 
now appears 
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5.03 Engraving Fill 
 

5.03.1 Engraving File Module and Settings 

• If you wish to fill in a shape with a line pattern, SignMaster offers an Engraving Module which can be 

opened by clicking on the Plugins icon  and selecting Engraving Module. 

• The following window opens and you will see your selected shape has already filled with lines: 

 

 

 

◊ In the top left corner are zooming tools. The View Mode icon can be toggled to add the original selected 
shape to the Preview window, if desired:                      

Click to add original 
shape to Preview 

Zoom 
tools 

Preview 

Engraving 
settings 

Click on 
Accept 
when done 

Check Keep Holes 

 Internal contour cuts are added 
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◊ Toolpath: There are four options in this menu: 

o None: no fill pattern is created 

o S-Sweep: a line fill pattern in which the tool stays down while filling the entire shape: 
 

 

 

o Line Fill: a line fill pattern in which the tool raises at each side, moves a “row” down, and then 
proceeds to the other side: 

 
 

 

 

o Island Fill: a progressive inset pattern based on the original shape; the tool drops to complete a 
path, raises, moves to the next path, drops to complete that path, etc.. Some shapes work better 
than others with an Island Fill: 

   

◊ Travel: four angles from which to choose, applying only to S-Sweep or Line Fill patterns: 
 

  
 
 

Original shape appears 

1. Tool start here and 
proceeds to the left 

2. Tool stays down, follows 
path of curve, then crosses 
to the right 3. Tool stays down, follows 

path of curve, then crosses 
to the left, etc. 

1. Tool start here and proceeds to the left 2. Tool raises 

4. Tool raises 3. Tool drops and 
proceeds to the right 5. Tool drops and proceeds to 

the left, etc. 

Diagonal - Up Horizontal 
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◊ Cut Perimeter: turn on this option if you want the original shape to be engraved as well: 

            

◊ Cleanup Flange: turn on this option to have an engraving of the original shape, but along the edges of 
the engraving lines. Note that there is also a Flange Offset setting which is a percentage distance from 
the original shape to the engraving lines. These settings are typically not needed with small diameter 
tools, like the Skycut engraver, so you most likely won’t have a need to activate Cleanup Flange.  

◊ Tool Diameter: The size of the engraving tip, pen nib, embossing tip, or other tool. For the Skycut 
engraver, use 0.004 inches or 0.1 mm. 

◊ Tool Offset: This setting is the distance between the engraving lines as a percentage of the Tool 
Diameter. Lowering this setting will decrease the spacing between the lines: 

      

◊ Hatch Offset: This setting controls the distance from the engraving fill to the outside perimeter of the 
original shape, again as a percentage of the tool diameter. A setting of 0% will extend the pattern all the 
way to the perimeter: 

   
 
 
 

Vertical Diagonal - Down 

Perimeter of shape is 
light, indicating it will 
NOT be engraved 

Perimeter of shape is 
dark, indicating it will 
also be engraved 

Cut Perimeter: 
checked 

Cut Perimeter: not 
checked 

Engraving lines are 
much closer together 

Tool Offset: 34% Tool Offset: 15% 

Hatch Offset: 35% Hatch Offset: 25% Hatch Offset: 0% 
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5.03.2 Inside Fills Versus Outside Fills 

• In certain situations, you might want to reverse the parts of a design that are filled. To do this, add any 
outside shape to the design, such as a rectangle, an oval, a heart, etc.  The engraving fill automatically fills 
the space between this new outside shape and the original design. 

◊ For example, if three stars are sent to the Engraving Module, then they will immediately fill with lines 
such as this: 

 

◊ If shapes are added around these stars, then the fill pattern reverses to fill the space between the 
original shapes and the new outside shapes: 

 

 

◊ If another shape is added to the outside of these shapes (a large rectangle is added to encompass the 
three shapes), then the fill will revert back to the original stars and a line fill is added between the 
rectangle and the outside shapes that were added: 

 

• If, for some reason, you want the outside shape present but NOT have the area between the two shapes 
filled, then only select the initial shapes (i.e. the stars) to send to the Engraving Module. 
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Appendix A  Troubleshooting FAQ’s 
 
 
 

A1 Communication Issues 

 

I cannot get the Skycut to power on. 

• Make sure the power cable is securely plugged into the adaptor. 

• Make sure the adaptor light is a steady blue light and it is plugged securely into the Skycut. 

• If you still cannot get the Skycut powered on, contact your dealer. 

____________________ 

 

I cannot power off the Skycut. 

• Press and hold the power button until the light shuts off. 

____________________ 

 

I cannot get Wi-Fi to work with my Skycut. 

• Set the Skycut close to the router when performing the initial setup presented in Section 1.12.2.  After 
establishing communication, you can test how far the Skycut can be located from your router. 

• In SignMaster’s Vinyl Spooler window, under the Connection tab, make sure you have selected TCP 
and entered the same IP address you selected during setup on the Skycut’s control panel: 

 

• Make sure your computer is connected to the same router as your Skycut. 

• Verify that SignMaster is the selected software on the control panel under Set>Sys Information. 

____________________ 

 

I cannot get USB to work with my Skycut. 

• Unplug/replug the USB cable at both the computer and at the Skycut. 

• In SignMaster’s Vinyl Spooler window, under the Connection tab, make sure you see USB Port and 
the Status says Device Connected. If not, repeat the instructions in Section 1.12.1. 

 

• Try a different USB port on your computer. 

• Verify that SignMaster is the selected software on the control panel under Set>Sys Information. 

• Try a different USB cable.  

 

____________________ 
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I had to cancel a cut. Now my Skycut is no longer responding when I click on Cut Now. 

• Try restarting the Skycut and SignMaster. 

____________________ 

 
 

A2 Operating Issues 

 

The control panel isn’t responding very well. 

• Press control panel icons with your finger and not your fingernail. You can also use a black rubber 
stylus. 

• Make sure the control panel is clean. 

____________________ 

My mat is rotating when the Skycut starts to cut! 

• Two pinch wheels need to be gripping the mat. Move the mat either left or right so that it is under two 
outer pinch wheels and the pinch wheels are aligned under white arrows. Refer to Section 1.09. 

• Make sure you are not trying to force the blade to cut too deeply and/or too quickly through a 
thick/dense material like chipboard or craft plastic.  Slow the speed, decrease the Force, and add more 
passes. 

____________________ 
 
 
My vinyl isn’t feeding evenly while cutting. It starts bunching up on the inside of the end cap. 
 

• Even if you feel the vinyl is aligned properly at the start of the cut, a slight “out of alignment” error will 
become more pronounced with a long cut. When you first drop the pinch wheels, use the arrow keys to 
feed the vinyl for the length of the cut to make sure it is feeding straight. If not, then about half-way 
through the length of the vinyl needed, lift the pinch wheels and realign the vinyl. Continue testing the 
alignment until you can verify that the vinyl is sufficently aligned for the entirety of your project.  

 
____________________ 

 
 
The pinch rollers are not tight enough to hold the vinyl I’m cutting. The vinyl is slipping and rotating when I start 
the cut. 

• The pinch wheels need to be over grit shafts (the dark gray rough areas along the revolving shaft. The 
white arrows will help you align the pinch wheels in correct locations. Also, use outside locations versus 
having, say, one pinch on the far right of the vinyl and a second pinch wheel only in the middle.  

 
____________________ 

 
 
I hear a terrible stuttering sound when trying to cut chipboard (or other thick dense material). 

• That can be a symptom of forcing the blade to cut too deeply and/or too quickly through the chipboard. 
Slow the speed, decrease the Force, and add more passes. 

 
____________________ 

 
 
I’m trying to do a PNC application and the camera can’t read the marks. 
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• Make sure you have calibrated the Skycut’s camera. The procedure is covered in Section 3.03. 

• On the control panel, go to Set>Camera and press Set. Make sure the Auto PNC option is marked. 

• If using the cutting mat, make sure the printout is aligned fairly straight on the cutting mat and the mat is 
fairly straight in the cutter.  

• Make sure the blade holder is over the lower right registration mark when starting the cut. 

• Are the registration marks printed dark with no streaking or missing ink?   

• Did you make any changes in the Contour Cutting Wizard after printing and before trying to cut? 
 

____________________ 
 
 
The Skycut stopped during a cut. 

• If the Skycut stops with the head over on the left side of the cutter, you have most likely exceeded the 
cutting range. Several things to consider:  

◊ Check the width (W) of your project (or the height H if in Landscape mode). It cannot exceed 16”. 

◊ Check how far you are moving the head to the left when setting the origin. If your project is 15” and 
you moved the head more than 1” to the left, you will send the cut out of range and the cutter will 
stop. 

• If the Skycut stops and the head is not located near the left side: 

◊ Make sure it’s not a communication issue. 

◊ You may have exceeded a buffer limit. Try reducing the number of nodes. Select the shapes and go 
to Curves>Node Editing>Reduce Nodes (Object).   

____________________ 
 
 

A3 Cutting/Drawing Issues 
 
 

My shapes are drawing (cutting) off the material. What am I doing wrong? 

• When setting the origin, make sure you are using the tip of the blade as the reference point and set the 
tip inside the corner of the material (not too close to an outside edge). 

• Verify that the preview window in SignMaster matches where you expect the shapes to cut as you view 
the material loaded into the Skycut itself. 

____________________ 

 

When drawing with the test pen (or cutting with the blade holder), I have extra lines being drawn (or cut). 

• Make sure you raise the pen (or blade holder) in the blade holder seat on the Skycut before tightening 
the screw. The blade holder seat needs to be able to drop the tool down when it reaches the spot to 
start the shape. Otherwise, the tool tip will be dragging across the material from the origin to where the 
shape will begin and then back to the origin at the end of the “cut”. 

____________________ 

 
 
I’m drawing with a pen and there are bubbles at the corners. 



 146 

• For perfect corners when using a pen, go to the Send to be Cut window and select Pen Mode so that 
Blade Offset  is set to 0. You do not need an offset for pens (or other tools like embossers and 
engravers).  

 

____________________ 
 

 
My cut started out fine but by the end of the cut, it’s not cutting through the material. 

• Make sure the blade holder housing doesn’t have any bits of material inside of it. 

• Make sure the screw on the blade holder seat is tight so that the blade holder isn’t slipping upwards 
during the cut. 

• Make sure the cutting mat is clean and sticky and the material is pressed down completely, so that the 
material remains stabilized during the cut.  

• Make sure the blade isn’t cutting too deep into the mat. This can sometimes cause the material to be 
pulled up and away from the mat as the blade releases from the plastic it is cutting. 

• Try increasing the cutting force by ~ 5 – 10. 

____________________ 
 

 
My cut is clean in some places but not in others. Why am I not getting consistent cutting? 

• Try raising the blade holder in the blade holder seat. If the blade is too close to the material, not enough 
force is being applied. Refer to Section 2.01.3, Set the Blade Height Above the Material. 

• Make sure your material is pressed firmly onto a clean and sticky mat (assuming you are cutting a 
material such as paper or cardstock). 

• Your material may require two passes if it’s not homogenous or if it is heavily textured. Sometimes 
intricate shapes also cut better with two passes. 

• Also, if the material has been exposed to humidity, then it will become difficult to cut in one pass.  You 
can dry both paper and cardstock using a blow dryer or in a very low-temperature oven.   

• If you are cutting vinyl without a cutting mat, check the cutting strip to make sure it is still in good 
condition. 

____________________ 

 
I have the outside edges of my chipboard completely taped but I’m not getting clean cuts, even after lots of 
passes. 

• Taping the edges prevents shifting of the chipboard but it’s not enough for stabilizing. You need to 
thoroughly press the entire surface of the chipboard onto a clean and sticky mat. Using a brayer is 
recommended. 

____________________ 

 
I am getting a lot of tearing in my cuts. 
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• A number of things can cause tearing so work through this check list:  

◊ Too much blade is exposed. If you see cut lines in your mat or the backing sheet, shorten the blade 
exposure. You should only be cutting through the material itself.  

◊ The blade is chipped. Try a different blade. 

◊ The paper is not adhered well to the mat. Make sure the mat is clean, sticky, and the paper is 
pressed smoothly and evenly on the surface. 

◊ You may be using too much cutting force. Try reducing it and doing test cuts.  

◊ You may have too many nodes in the shape. Select the shapes and go to Curves>Node 
Editing>Reduce Nodes (Object).   

◊ The material itself may be subject to tearing, especially on intricate cuts.  Also, if the cardstock has 
been exposed to humidity, then the moisture in the material can make it difficult to cut cleanly. You 
can dry paper and cardstock using a blow dryer or in a very low-temperature oven.   
 

____________________ 

 
I’m cutting very small lettering and the letters are a bit distorted. 

• Verify that you are using the correct Blade Offset. 

• Try slowing down the cut. Small lettering needs slower speed. 

____________________ 

My cut shapes are not the same dimensions as what they are set to in SignMaster. 

• Perform the calibration procedure shown in Section 2.08. 

____________________ 

 
My shapes are not completely cutting out. They are still attached to the waste part of the material.  

• Make sure you have set an appropriate Overcut setting. 

• Make sure the mat is not skewing during the cut. This can happen if even one of the pinch wheels is no 
longer centered under a white arrow.  It can also happen if the speed and/or pressure is set too high. 

 
_____________________ 

 
My cardstock is not cutting all the way through. I have the blade all the way out and using the maximum force. 

• Please refer to Section 1.07.3. It’s important to only have as much blade exposed as is necessary to 
penetrate the cardstock. You may also need to raise the blade tip height (Section 2.01.3). Reduce your 
force back to suggested values for the material you are cutting and do a test cut. 

• Do not use more force than is needed. If the cardstock is cutting through about 90% of the cut, then 
turn on Multi-Cut. Some cardstocks do better with a second pass at a lower force. 

____________________ 

 
I calibrated the camera for print and cut and the cuts start off accurate but, by the end of the cut, there is a lot of 
error. 

• This is called “drift” and can sometimes be corrected by slowing the speed and making sure the cuts 
aren’t so deep that the blade is causing some drag to occur.  

• An alternative solution is to add intermediate registration marks. Refer to Sections 3.08 and 3.09.2. 

____________________  
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Appendix B Activating Commands 
 

• This section shows you how to activate commands in order to add certain functions to the control panel. 

• Go to Set>Advance settings>System Mode and press the cmd… button: 

 
 

• The following screen opens. Press Input: 

 

• The Input code is entered in the same way as you entered your Network password but since it’s a 3-digit 
code, you’ll begin by pressing the 123 button: 

   

 

Press cmd…  

Press Input  

Numeric keys appear  Press 123  
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• Enter the required Input code according to the following: 

◊ 021: Activate Mark Set  

◊ 020: Deactivate Mark Set 

◊ 031: Activate Passes Set 

◊ 030: Deactivate Passes Set 

◊ 141: Activate QR Cut 

◊ 140: Deactivate QR Cut 

• After entering the Input code you need, click on OK and the Input screen will return. The word RUN will 
now be highlighted and you can press it.  The Skycut will beep once. 

   

• Return to the main screen and press USB, the activated button will now appear: 

 

 

 

 

 

Press RUN… 

Enter code by 
pressing keys 

Press OK when done 

Passes Set now 
appears 
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FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance 
could void the user's authority to operate this equipment. 
 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
 (1) This device may not cause harmful interference, and  
(2) this device must accept any interference received, including interference that may cause undesired 
operation. 
This device and its antenna(s) must not be co-located or operating in conjunction with any other antenna or 
transmitter. 
 
NOTE:  
This equipment has been tested and found to comply with the limits for a Class B digital 
 device, pursuant to Part 15 of the FCC Rules.  
These limits are designed to provide reasonable protection against harmful interference 
 in a residential installation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance with the instructions, 
 may cause harmful interference to radio communications.  
However, there is no guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged to  
try to correct the interference by one or more of the followingmeasures: 
-- Reorient or relocate the receiving antenna. 
-- Increase the separation between the equipment and receiver. 
-- Connect the equipment into an outlet on a circuit different from that to which the 
 receiver is connected. 
-- Consult the dealer or an experienced radio/TV technician for help. 

This equipment complies with FCC radiation exposure limits set forth for an 

uncontrolled environment. This equipment should be installed and operated at least 20cm between the radiator 
& your body. 


